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Anotace 
Cílem bakalářské práce je shrnutí poznatků 3D vizualizací několika typů 

dámských postav z hlediska použití textilních materiálů s rozdílnými mechanickými 

vlastnostmi a výsledného padnutí oděvu. 

Úvodní část práce se zabývá mechanickými vlastnostmi materiálů ovlivňující 

padnutí oděvu, jejich měřením a studií týkající se morfologickécharakteristiky postav. 

Dále také oblastí počítačových CAD systémů vhodných pro modelovou úpravu 

střihových dílů a 3D simulaci oděvního výrobku na virtuální postavě. 

V praktické části je upraven reprezentativní oděv(šaty) v softwaru AccuMark 

s exportováním střihové dokumentace do programu V-Stitcher. Následně je provedeno 

měření definovaných mechanických vlastností oděvních materiálů, které slouží 

jako vstupní parametry pro 3D simulaci oděvu. 

 

Klíčová slova: 3D simulace, CAD systémy, mechanické vlastnosti textilií, somatograf, 

somatotyp, V-Stitcher. 

  



 
 

Summary 
The aim of the bachelor’s work is to summarise findings of 3D visualization 

of several types of woman figures in light of application of textile materials 

with different mechanical properties and resulting fitting of clothing. 

The introductory part is concerned withmechanical properties of materials 

affecting fitting of clothing, their measurements and studies of morphological 

characteristics of the figures. It deals also areas of CAD computer systems appropriate 

for creative forms of pattern cutting and 3D simulation of garments on a virtual figure. 

In the practical part representative clothing (dresses) is modified in software 

AccuMark with exporting of pattern cutting to V-Stitcherprogramme. Consequently, 

the defined mechanical properties of clothing textile materials, which serve as input 

parameters for 3D simulation of garments, are measured. 

 

Key words: 3D simulation, CAD systems, mechanical properties of clothing materials, 

somatograf, somatotype, V-Stitcher.  
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Úvod 

Téměř denně jsme zahrnováni novými, rychlejšími a efektivnějšími programy 

jak pro domácí uživatele, tak i celou řadou systémů pro oděvní průmysl. Dnes nikoho 

nepřekvapí, že tyto produkty zvládají práci ve 2D a 3D prostředí. 

Počátky virtuální reality se objevují na konci šedesátých let. Jedná se o úplně 

nové uživatelské rozhraní, jehož cílem je co nejvíce přiblížit počítačové prostředí 

skutečnosti tak, jak jsou zachycovány našimi smysly. Virtuální zobrazování lidské 

postavy se dostavá do popředí i v oděvním průmyslu. Umožňuje designerům realistické 

3D simulace řasení a záhybů materiálů, navrhování vzorů a barev. Kvalita obrazu 

výsledného zobrazeného modelu je závislá na vývoji 3D softwaru a na kvalitě vstupních 

dat, která jsou jedním z cílů zkoumání bakalářské práce. 

Rešeržní část práce se zaměřuje na typovou charakteristiku postav 

a na definování mechanických vlastností plošných textilií ovlivňující padnutí oděvu 

a způsob, jakje objektivně změřit. Informace jsou v experimentální části vyhodnoceny 

a některé z nich jsou použity jako vstupní hodnoty pro simulaci v 3D softwaru  

V-Stitcher.  

Cílem práce je na základě teoretických a praktických poznatků vytvořit 

střihovou dokumentaci vybraného oděvu v CAD systému AccuMark firmy Gerber 

Technology s následnou 3D simulací dámských šatů na třech typech virtuálních postav 

v programu V-Stitcher s ohledem na import změřených hodnot definovaných 

mechanických vlastností materiálů. U provedených simulací se vyhodnotí výsledné 

padnutí oděvu na virtuálním avatarovi s ohledem na typ materiálu a typ postavy. 

Práce poukazuje na snadnou a relativně rychlou činnost v CAD systémech, jak 

vytvořenou 2D střihovou konstrukci detailně promítnout na 3D postavě, čímž systém 

výrazně snižuje čas potřebný k vývoji a odzkoušení oděvu. Poskytuje zobrazení 

výrobku ještě před jeho ušitím a možnost sdílení kolekce s odběrateli a dodavateli 

v předvýrobním i výrobním procesu.  
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1 Mechanické vlastnosti plošných textilií 

Mechanické vlastnosti zahrnují celou řadu vlastností textilních vláken, které 

mají důležitý význam jak pro zpracování, ale také pro spotřebitele. Mechanické 

vlastnosti popisují schopnost vláken měnit tvar (deformovat se) při mechanickém 

působení sil. Textilní materiály jsou ve většině případů namáhány opakovaně, proto je 

důležité hodnotit jejich kvalitu. 

Definované mechanické vlastnosti, které jsou níže uvedeny a popsány, slouží 

jako vstupní parametry pro 3D simulaci oděvního výrobku v programu V-Stitcher. 

Některé z nich jsou v experimentální části objektivně změřeny.  

1.1 Třídění mechanických vlastností 

Třídění mechanických vlastností dle účinku vnějších sil: 

• deformační – průběh deformace materiálu, elastické, viskoelastické 

a plastické, 

• destrukční –mechanické porušení materiálu. 

 

Třídění mechanických vlastností dle časového režimu namáhání: 

• statické, 

• dynamické. 

 

Tříděné mechanických vlastností dle způsobu namáhání se rozlišují vlastnosti vyvolané: 

• působením tahu, 

• smyku, 

• tlaku, 

• krutu,  

• ohybu. [1] 

1.1.1 Tažnost 

Vzrůstajícím postupným zatěžováním vlákna dochází k jeho protažení. Definuje 

se jako poměr mezi původní délkou materiálu a prodloužením zkušebního vzorku 

po působení zatížení. K přetrhu materiálu dochází, pokud je působení mechanické síly 



3 
 

vyšší než chemické a fyzikální vazby působící ve vlákně. Při namáhání v tahu dochází 

k uvolňování tepla, vzniku elektrostatického náboje, změně termických a mechanických 

vlastností. 

Pevnosti a deformace vláken tahem jsou nejčastěji používanými hodnotami 

charakterizující mechanické vlastnosti vláken.  

Tažnost (1) – poměrné prodloužení se vyhodnotí dle vztahu: 

  = ∆   ∙ 10  [%]        (1) 

 ε tažnost, 

 ∆l absolutní prodloužení [mm], 

 l0 upínací délka trhacího stroje [mm].[1] 

1.1.2 Pružnost 

Pružnost, nazývána též elasticita, se definuje jako schopnost plošné textilie 

se deformovat pod vlivem působení vnější síly a po odstranění se zotaví a vrátí 

se do původního stavu. Celková deformace se skládá z deformace elastické (vratné), 

která se celá vrátila. Tu lze očekávat v oblasti malých deformací. Deformace plastické 

(nevratné)se projevují zůstatkovým protažením. U technických materiálů se závislost 

popisuje Hookeovým zákonem. Tuto definici ale nelze použít pro textilní materiál, 

protože není přesně definována plocha průřezu vláken. 

Modul pružnosti je první derivací funkce tahové křivky (viz Obrázek 1), která 

se zobrazuje pomocí grafu. Změří se úhel α a vypočítá se tg α. U textilií se proto 

používá termín počáteční tangentový modul Ep. Bod P je místo, kde tečna v počátku 

opouští tahovou křivku, a definuje se jako mez pružnosti. [2] 
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  Obrázek 1–Tahová křivka [2] 

 

1.1.3 Smyk 

Hodnota smyku materiálu se hodnotí jako deformace ve směru osnovy a útku 

při působení třecích sil v rovině plochy.Hodnota smyku je důležitá pro padnutí oděvu. 

Dle KES se zkoumaný vzorek upne mezi pohyblivou a pevnou čelist o délce 200 

mm, které jsou od sebe vzdálené 50 mm. Při pohybování čelistí pod úhlem ± 8 stupňů 

se vzorek natahuje a deformuje. Měření se provádí ve směru útku i osnovy. [3] 

1.1.4 Tuhost v ohybu 

Tuhost v ohybu je fyzikální veličina, která je vyjádřena jako reakce textilie 

působící proti vnějším silám nebo proti působení gravitace. Ohybová tuhost je jedna 

z mechanických vlastností související s omakem, splývavostí a je určena konstrukcí 

textilie a její úpravou. Při vyšším odporu textilie proti ohýbání má textilie vyšší 

ohybovou tuhost, ale horší splývavost. Ke stanovení tuhosti je možné použít několik 

metod statických i dynamických. Statické metody podávají informace o okamžité 

tuhosti plošné textilie a jsou založené na odečtení úhlu ohybu. Dynamické metody 

ohybu podléhají cyklickému zatěžování.[4], [5] 

Pro zjištění ohybové tuhosti a dalších mechanických vlastností (plošná měrná 

hmotnost, pružnost apod.) je možné použít přístroj FTK (Fabric Testing Kit) a FAST 

(Fabric Assurance by Simple Testing) (viz Obrázek 2), který je s použitým softwarem 

kompatibilní. [6] 
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  Obrázek 2 - Fabric Testing Kit [6] 

 

Pro vypracování bakalářské práce bylo potřeba použít metodu, kterou popisuje 

manuál k softwaru V-Stitcher, viz experimentální část. 

1.2 Vlastnosti tvaru plošných textilií 

Do těchto vlastností spadají parametry, které popisují a určují tvar plošné textilie 

a ovlivňují další vlastnosti, např. stálost tvaru a propustnost.  

Patří sem následující vlastnosti: 

• tloušťka a stlačitelnost, 

• plošná měrná hmotnost, 

• objemová měrná hmotnost, 

• pórovitost, 

• konstrukce plošné textilie. [5] 

1.2.1 Tloušťka 

Tloušťku plošné textilie můžeme definovat jako kolmou vzdálenost mezi 

přítlačnou čelistí a podkladovou deskou měřícího zařízení. K měření tloušťky textilie 

se používá tloušťkoměrů různých konstrukcí. Zkoušený materiál je položen 

na podkladovou desku a přitlačen kruhovou čelistí, která vyvíjí přesně daný přítlak 
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na zkoušenou plochu. Velikost přítlaku a plocha horní čelisti je předepsána v normě 

ČSN EN ISO 5084 a jsou určené pro různé typy materiálů. [5] 

Důležitým parametrem měření tloušťky je přítlak mezi čelistmi. Ten je dán 

plochou přítlačné horní desky a silou, kterou deska na textilii působí. Definuje se jako 

měrný tlak. (2) 

   =    [  ]         (2) 

 Pm měrný tlak [Pa], 

 F působící síla [N], 

 S plocha čelisti [m2]. 

  

Tento přítlak je vyrovnáván vnitřním odporem textilie. Pokud by byl materiál 

měřen ihned po vložení přítlaku, nedošlo by k ustálení deformací textilie a dospělo by 

se k jiným výsledkům než po určitém čase. Pro správnost měření se musí zachovat 

časový interval, který je v normách stanoven na 30 sekund. Z výkladu je patné, 

že při aplikování různých přítlaků změříme různé tloušťky. To popisuje Sommerův 

vztah. (3) 

  =                  [  .        ]      (3) 

 S stlačitelnost, 

 P1, 2 tlak [Pa], 

 h1, 2 odpovídající tloušťky [mm].[7] 

1.2.2 Plošná měrná hmotnost 

Jedná se o definování hmotnosti plochy plošné textilie, která je vztažena k této 

ploše a je vyjádřená v g.m-2. K určení plošné hmotnosti (4) se zváží klimatizovaný 

přesně odměřený vzorek plošné textilie a vypočítá se plošná měrná hmotnost 

dle vztahu:  

   =   [ .   ]        (4) 

 Mp plošná měrná hmotnost [g.m-2], 

 m hmotnost klimatizovaného vzorku [g], 

 S plocha vzorku [m-2].[4] 



7 
 

1.3 Stálosti tvaru plošných textilií 

Stálost tvaru popisuje změny tvaru plošných textilií, ke kterým dochází 

působením vnějších i vnitřních sil a působením tělesné teploty a vlhkosti.  

Stálosti tvaru ovlivňují: 

• sráživost, 

• tuhost v ohybu, 

• splývavost, 

• mačkavost. [5] 

1.3.1 Sráživost 

Sráživost (5) vyjadřuje změnu rozměrů textilie po dobu působení vody, vlhkosti 

anebo tepla. Po dobu působení daného namáhání (praní, žehlení, zavlhčování) 

se následně zkoumají změny rozměrů textilie, sražení v přímém i podélném směru. 

  =          ∙  10 [%]        (5) 

 S sráživost [%], 

 l0 původní rozměr vyznačený na vzorku [mm], 

 ls změřený rozměr po namáhání [mm]. [4], [5] 

1.3.2 Splývavost 

Splývavost textilie se definuje jako schopnost textilie vytvářet estetické záhyby 

při zavěšení do prostoru. Záhyby jsou důsledkem působení malých sil a deformací, 

které jsou způsobeny gravitačním zrychlením. Rovnají se elastickým (vratným) 

deformacím. 

Koeficient splývavosti se vypočítá podle vztahu: (6) 

  =        ∙ 100 [%]        (6) 

 X koeficient splývavosti [%], 

 S plocha zkoušeného vzorku (706,9 cm2),  

 Sp plocha průmětu, 

 Sm plocha mezikruží (452,4 cm2). [8] 
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1.4 Vlastnosti povrchu plošných textilií 

Povrchové vlastnosti se projevují řadou charakteristik ovlivňující její 

reprezentativní vlastnosti. Používáním oděvu se tyto vlastnosti zpravidla zhorší, čímž je 

zkrácena doba trvanlivosti a atraktivnost výrobku (odstávající vlákna, horší vybarvení, 

zatrhává se atd.). 

Vlastnosti dělíme podle: 

• lesk - mat, 

• oděr, 

• otěr, 

• klouzavost, 

• zátrhovost, 

• žmolkovitost. [5] 
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2 Objektivní měření mechanických vlastností textilií 

Cílem objektivního hodnocení mechanických vlastností plošných textilií je 

nahrazení subjektivního hodnocení, které bývá náročné na čas a na hodnotitele. 

2.1 KES - FB (Kawabata Evaluation System for Fabrics) 

Pro 3D vizualizaci materiálu, jeho splývavosti a padnutí oděvu na realistickém 

virtuálním těle software potřebuje střihové díly a databázi vlastností materiálu. 

Vlastnosti materiálu lze zjistit pomocí různých objektivních metod např. měřícími 

přístroji KES-FB. 

Systém měřících přístrojů KES-FB navržený profesorem Sueou Kawabatou 

na univerzitě Kyoto v Japonskuje nejpoužívanějším zařízením pro objektivní hodnocení 

textilií. Měřením mechanických vlastností textilií nedochází ke zničení zkoušených 

vzorků jako u řady jiných metod.Všechna měření se provádí ve směru osnovy a útku.  

Systém měření zahrnuje sadu čtyř přístrojů FB 1 – 4, dokáže testovat šestnáct 

charakteristických vlastností plošných textilií s dělením do skupin:  

• tahové (linearita, deformační energie, pružnost), 

• smykové (smyková tuhost, hystereze), 

• ohybové (tuhost, hystereze), 

• tlakové ( linearita, energie, pružnost) 

• povrchové (koeficient tření, geometrická drsnost), 

• objemové (plošná hmotnost, tloušťka). [9] 

2.1.1 Měřící systém: 

• KES – FB 1 – měření tahu a smyku, 

• KES –  FB 2 – měření ohybu , 

• KES – FB 3 – měření tlaku , 

• KES – FB 4 – měření povrchových vlastností. [9] 



10 
 

2.2 FAST (Fabric Assurance by Simple Testing) 

Systém FAST slouží k měření mechanických a rozměrových vlastností. Byl 

vyvinut pro predikci chování textilií při šití a pro predikci komfortu. Skládá 

se z přístrojů měřící objemové, ohybové, tahové a střihové vlastnosti a vlastnosti 

rozměrové stability. [9] 
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3 Proporcionalita lidského těla 

Estetickou náplň lidského těla určují vzájemné poměry jednotlivých částí těla, 

nebo poměry těchto částí k celému tělu, které se označují jako tělesné proporce. 

Rozlišujeme proporce délkové, příčné a hloubkové.  

Proporce těla se během vývoje mění v závislosti na pohlaví, genetické dispozici, 

rasové příslušnosti a životním stylu. Změřením určitých tělěsných rozměrů lze stanovit 

tzv. průměrnou postavu neboli ideální proporce s nejvyšší četností, ale i okrajové typy 

postav zastoupené menším počtem. [10] 

Už od starověku byly proporce prezentovány pomocí estetických kánonů. 

Graficky shrnují pravidla, podle kterých je velikost jednotlivých tělesných částí určena 

jako násobek (modulem jsou výška hlavy, délka prstu, délka chodidla apod.) nebo podíl 

modulu. [11] 

3.1 Typologie postav 

V novodobém zkoumání postav se především využívají metody měření těla 

(somatometrie), které jsou doplněny o starší metody pozorování těla (somatoskopie). 

S vývojem techniky a technických poznatků nabývá na významu použití počítačové 

a digitální technologie. Během vývoje lidské populace bylo vytvořeno velké množství 

typologických kategorií. Tato práce se se zaměřuje na malou část z nich. [12] 

3.1.1 Typologie dle Ernesta Kretschmera 

Německý psychiatr Ernest Kretschmer vycházel ve svém typologickém systému 

z psychologie dvou protichůdých skupin lidí - extrovertů a introvertů. Ze svých 

zkušeností vyvodil, že existuje souvislost mezi tělesným typem a duševním 

onemocněním. Tělesné typy rozdělil na tři skupiny a dva okrajové typy s extrémní 

podobou, které jsou uvedeny na obrázku 3. [12] 
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  Obrázek 3 –Typologie postav dle Ernesta Kretschmera [12] 

3.1.2 Typologie dle Williama Herberta Sheldona 

Američan a vedoucí vědeckého týmu během 40. let 20. stol. vytvořil 

typologickou variantu odlišnou od všech dosavadních. Vycházel z požadavku definovat 

tělesnou stavbu člověka, aby byla stanovena na základě tvarů a rozměrů těla. Vybral 

17 přímých horizontálních rozměrů. 

Sheldon zavedl pojem somatotyp (viz Obrázek 4), který definoval jako vztah 

3 komponent – morfologických složek (viz Tabulka 1). Somatotyp je určen kombinací 

tří číselných hodnot v rozmezí 1-7. [12] 

 

Tabulka 1: Morfologické složky a označení extrémních typů[12] 

Morfologická 
složka Charakteristika složky Typ zárodečné tkáně 

Označení 
extrémního 

typu 
Endomorfní Silně vytvořené trávicí orgány Endoderm –vnitřní 711 
Mezomorfní Převaha svalstva, kostí, tkání Mezoderm – střední 171 
Ektomorfní Velký tělesný povrch Ektoderm – vnější 117 
 



13 
 

 
Obrázek 4 – Endomorf, Mezomorf, Ektomorf [12] 

3.1.3 Typologie dle Barbary Heath a Lindsay Carter 

Jedná se o nejznámější a nejvíce používaný systém vytvořený modifikací 

Sheldonovy typologie. Heath-Carter systém definuje somatotyp jako bodové zobrazení 

vyjádřené trojicí čísel endomorfní, mezomorfní a ektomorfní morfologickou složkou, 

vždy v tomto pořadí uvedeno v tabulce 2. [12] 

 

Tabulka 2: Morfologická stavba [12] 

Morfologická 
složka 

Hodnotící kritéria 
Označení 

složky 

Endomorfní Množství podkožního tuku, relativní tloušťka či hubenost ENDO 

Mezomorfní Poměr rozvoje svalově-kosterní mohutnosti MEZO 
Ektomorfní Poměr relativní délky těla, tělesný index EKTO 
 

Hodnota složky ½ až 2½ je považována za nízkou, 3 až 5 střední, 5½ až 7 

vysokou a 7½ velmi vysokou.  

Morfologické hodnocení somatotypu se znázorní do dvourozměrného 

somatografu se souřadnicemi X, Y. Body na somatografu se nazývají somatopozice. 

Ostatní rovnice pro výpočet a analýzu dat jsou uvedeny v příloze A. Souřadnice 

somatografu se vypočítají dle vztahu: (7), (8) 

 X = EKTO – ENDO        (7) 

 Y = 2 x MEZO – (ENDO + EKTO)      (8) 
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Podle vzájemných poměrů komponentů (složek)se somatotypy slučují do 13 

různých kategorií nebo do čtyř základních. Název kategorie s podobnými nebo stejnými 

morfologickými vztahy je pojmenován podle názvu převládajících komponentů 

(viz Obrázek 5).[13] 

 

 
 

Obrázek 5–Somatograf [13] 

3.1.4 Projekt Digital Human 

Jedná se o třídimenzionální systém sloužící k realistickému vzhledu lidského 

těla pomocí počítačové grafiky s využitím matematické statistiky (použití laserových 

snímků 250 dobrovolníků). Byl vytvořen algoritmus pro úpravu obecné šablony podle 

každého snímku, což umožňuje pozvolné přechody mezi tvary těla (viz Obrázek 6). 
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   Obrázek 6 - Přechody mezi tvary těla [12] 

 

Na základě souboru zrekonstruovaných a charakterizovaných modelů lidského 

těla byla vytvořena statistická analýza tvarů lidského těla a analýza hlavních 

komponentů. Další možností využití je vyhodnocení vztahů dat a tělesných tvarů. Toho 

se používá při tvorbě modelu závislosti tvaru těla na výšce postavy a hmotnosti. [12] 

3.1.5 Kategorie typů postav dle Fabulous Fit 

Pokud jde o celkové morfologické typy postav (viz Obrázek 7), je zde několik 

typických vzorů rozložení tělesné hmotnosti a proporcí. Můžeme je rozpoznat nebo 

identifikovat podle specifických oblastí na těle, kde má váha tendenci se hromadit 

bez ohledu na výšku.  

Záleží na dané postavě, jejich přednostech a nedostatcích, jak docílit optické 

vyváženosti a co nejblíže se přiblížit ideálnímu typu postavy. Jaké vybrat správné 

oblečení pro každý typ postavy, jaký zvolit střih, materiál a barvujsou dalším vodítkem 

pro výrobce a návrháře, jak se nejvíce přiblížit ideálnímu typu postavy. 

 

„Ideální typ postavy” 

Tento typ postavy je stejný v šíři ramen a šíři boků, se středně velikým poprsím 

a štíhlým pasem, který je asi o 25 cm menší než obvod boků. 

 

Typ postavy „Trojúhelník”  

Postava se zdá menší, užší nad pasem a širší v místě boků. Působí nevyrovnaně 

odshora dolů. Ramena jsou užší než boky, nebo šikmé, takže se jeví užší. Postava má 

zaoblené hýždě a stehna často silnější (dominantní boční křivka). Při růstu hmotnosti 

se tuková a svalová hmota ukládá do spodní části těla jako první.  
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Typ postavy„Obrácený trojúhelník” 

Typ obráceného trojúhelníku má větší obvod nad pasovou přímkou a menší nebo 

užší pod ní. Kosti jsou obvykle střední velikosti a hmotnost je soustředěna v ramenou, 

horní části zad, poprsí, nebo ve všech třech oblastech. Postava je směrem dolů 

nevyvážená a ramenní oblast výrazně širší než v oblasti boků. V pase je střední 

až široká. 

 

Typ postavy „Obdelník” 

Typ se objevuje s téměř stejnou šířkou v ramenou, pasu a bocích (tvoří vertikální 

přímku), ale pasová přímka není výrazná a jeví se široká v poměru k bokům. Šířka 

přes stehna je obecně stejná jako šířka sedu.Torzo (horní polovina těla) postavy je malé 

až střední.  

 

Typ postavy „Přesýpací hodiny” 

Postava přesýpacích hodin se jeví větší nebo plně kulatá v oblasti poprsí 

a oblasti boků, ale je velmi malá v pase.Torzo je obecně větší než průměr. Pas a oblast 

horní části boků se zužuje do úzkéhopasu, boky a hýždě jsou hladce zaoblené. Postava 

není považovánaza ideální, protože příliš úzký pas je vůči poprsí a sedu poměrně větší. 

 

Typ postavy „Diamant” 

Tento typ postavy je nejméně častý a je charakteristický poměrně úzkými 

rameny a boky v kombinaci s velkým břichem a širokým pasem.Torzo je obvykle menší 

s vysokými rovnými boky,občas tvar boku připomíná srdce. Hmotnost se soustřeďuje 

do břicha a pasu.  
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Obrázek 7 – Typy postav [14] 

 

Další dvě kategorie postav mohou nebo nemusí být považovány za specifické 

typy, záleží na úhlu pohledu. Jsou však typické a snadno rozpoznatelné. 

 

Typ postavy „Úzký obdelník” 

Kategorie je podobná obdélníkové postavě, jen tenčí, protože hmotnost je 

výrazně nižší než průměrná nebo ideální. Zdá se téměř rovná s poměrně úzkými rameny 

a boky. Malé tělo v pase i hýždích, tenké paže a nohy - velmi málo osvalená 

bez tendence k tloustnutí a ukládání tuků.  

 

Typ postavy „Ovál” 

Postava je v oblasti těla plně zaoblená. Hmotnost je znatelně vyšší, než je 

průměr nebo ideální rozsah. Horní část ramen a zad se typicky zaobluje, stejně tak 

poprsí, břicho, pas, hýždě, boky a horní končetiny. [14] 

3.2 Velikostní systémy oděvních výrobků 

Velikostní sortiment je souhrn stanovených velikostí pro danou kategorii 

populace členěný do skupin podle tělesných rozměrů (vp, oh, op, os). 

Pro vypracování tématu bakalářské práce byl vybrán německý velikostní 

sortiment DOB pro ženy a dívky. [15] 
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3.2.1 Velikostní sortiment DOB 

Podstatou sortimentu je využití intervalu obvodu hrudníku pro malé a velké 

velikosti. Sortiment člení velikosti dle výšky a dle typu postavy: 

• podle výšky postavy – nízká (160 cm), střední (168 cm), vysoká 

(176 cm), 

• podle typu postavy – úzké boky, normální boky, široké boky. 

 

Označovaní velikostí se provádí pomocí číselných symbolů.Odstupňované 

hodnoty pro menší i větší velikosti se značí s postupovým číslem 2. Značení velikostí 

se širšími boky má před číslem velikosti symbol 5 a velikost s užšími boky symbol 0. 

Nižší výškové velikostní skupiny se značí poloviční hodnotou znaku středové výškové 

skupiny, větší výškové skupiny pak dvojnásobkem znaku. [12] 
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4 CAD systémy pro konstruování a simulaci oděvu 

Počítačem podporovaný návrh a návrhářské systémy jsou obvykle využívané 

návrháři k vytvoření vizuálního obrazu tkanin, šatů a dalších produktů na obrazovce 

počítače. CAD systémy poskytují nové úrovně tvůrčí svobody stejně jako zvýšenou 

rychlost, vyšší produktivitu a větší pružnost v procesu návrhu. [16] 

4.1 AccuMark 

Software AccuMark firmy Gerber slouží k projektování oděvních střihových 

konstrukcí, stupňování a polohování. Součástí programu je kompletní sada nástrojů 

pro tvorbu střihůa také mnoho dalších nástrojů, které pomáhají rychle reagovat 

na změny na trhu s oděvy. AccuMark usnadňuje a urychluje: 

• konstrukci střihů – provádí několik operací současně, automatické 

promítnutí úprav do příslušných dílů, možnosti navolnění, záševků 

a záhybů, 

• stupňování – tvorba, úprava a měření velikostí pomocí účinných 

a snadno ovladatelných stupňovacích nástrojů, přizpůsobení zástřihů 

při změnách velikostí, 

• polohování a šetří materiál – náhled na využití materiálu, zvýšení 

výtěžnosti pomocí specifických nástrojů, funkce automatického 

sesazování, spojování poloh, 

• správu dat a komunikaci – nástroje hledání pro správu dat, snadný vstup 

z digitizéru, import a export ze systémů CAD, on-line nápověda, 

• řízení střihacích procesů – definuje trajektorii střihu pro automatické 

cuttery, ovládá směr výřezu u zrcadlových dílů. [17] 

4.2 V-Stitcher 

Tento software umožňuje transformovat dvourozměrné (2D) modely 

do třírozměrných (3D) oděvů. Simuluje strukturu tkaniny a dobré padnutí oděvu tak, 

že oděv zobrazí na virtuálním lidském těle na základě vzoru, materiálu a reálných 

datech předem vybraných. Vytváří virtuální oděvy z 2D šablon z programu AccuMark 
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PDS – Pattern Design Software, které je možné si ve 3D prohlédnout, jak padnou. 

Umožňuje spolupracovat přes internet s klienty nebo dodavateli a podněcuje tak 

zhodnocení oděvu, zpětnou vazbu a modifikaci. [18] 

V-Stitcher šetří náklady a čas potřebný na ušití a odzkoušení oděvních vzorků. 

Při nevyhovujícím padnutí oděvu na postavě lze střihové úpravy provést veV-Stitcheru. 

[19] 
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Experimentální část 

5 Charakateristika vybraných materiálů 

Před výběrem materiálů bylo provedeno měření splývavosti na deseti vzorcích. 

Na základě výsledků měření (viz příloha B) se vybraly tři materiály s rozdílným 

materiálovým složením, vazbou, plošnou měrnou hmotností a koeficientem splývavosti, 

na kterých byl proveden experiment s 3D vizualizacemi v programu V-Stitcher. 

 

Tabulka 3: Charakteristika materiálů 

Materiál č. Obrázek materiálu 
Plošná měrná 

hmotnost [g.m-2] 

Složení 

materiálu 

1 

 

150,6 
80% viskoza 

20% len 

2 

 

83,4 100% bavlna 

3 

 

262,6 
98% bavlna 

2% lycra 

5.1 Měření splývavosti 

Pro hodnocení splývavosti textilií byla použita metoda obrazové analýzy 

se softwarem Lucia sloužící pro digitální zpracování obrazu a měření plochy průmětu, 

která se porovná s plochou původního vzorku. Každý z deseti vzorků se měřil čtyřikrát 

(naměřené hodnoty a koeficient splývavosti je uveden v příloze B). Z hodnot 
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se vypočítaly průměrné hodnoty plochy průmětu a dále se stanovil koeficient 

splývavosti X. 

Na základě hodnocení splývavosti zkoumaném na deseti vzorcích byly vybrány 

tři vzorky, na kterých je proveden experiment. Byly vybrány tkaniny v různé vazbě, 

plošné měrné hmotnosti a s rozdílným složením. Koeficient splývavosti tří vzorků 

společně s obrázky pořízenými kamerouje uveden níže v tabulce 6. 

 

Tabulka 6: Vyhodnocení koeficientu splývavosti 

Materiál 

č. 

Koeficient 

splývavosti 

X  [%] 

Obraz sejmutý 

kamerou 
Binární obraz 

1 78,53 

  

2 46,98 

  

3 17,65 

  

5.2 Měření tloušťky materiálu 

Tloušťka byla naměřena pomocí digitálního tloušťkoměru SDL M034A, který je 

možný použít v laboratoři na katedře oděvnictví. Před samotným měřením se přístroj 

zkalibroval za účelem přesného měření. Měření bylo prováděno na všech třech 

materiálech. Měřený materiál nemusí mít přesně stanovaný rozměr, musí být pouze 

větší, než je plocha přítlačné desky. Vzorek musí být bez jakéhokoliv poškození 

a všechny proměřené plochy se musí měřit nejméně 150 mm od kraje plošné textilie. 
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Dle normy byl nastaven přítlak 1000 Pa a velikost přítlačné hlavice 20 cm2. Naměřené 

a vyhodnocené hodnoty pomocí softwaru jsou uvedeny v příloze B. 

5.3 Měření plošné měrné hmotnosti 

Pro změření plošné hmotnosti bylo použito elektronických vah KERN EG 

3003M s vážením na tři desetinná místa. Ke změření byly použity vzorky odstřižené 

přesně po niti (osnova a útek) o rozměrech 0,1 x 0,1 m. Vzorky byly předem 

v laboratorních podmínkách klimatizovány na 20°C při relativní vlhkosti 65 % na 24 

hodin a následně zváženy. V příloze B jsou uvedeny vyhodnocené plošné hmotnosti. 

5.4 Měření ohybové tuhosti 

Ohybová tuhost byla měřena podle metody uvedené v manuálu programu  

V-Stitcher (viz kapitola 1.1.4). Pro vyhodnocení ohybu (viz Obrázek 8) softwarem 

potřebuje kalkulátor několik naměřených hodnot- plošnou měrnou hmotnost, délku 

převisu, vzdálenost převislého okraje tkaniny k vyvýšené desce, výšku vyvýšené desky. 

Při změření úhlu ohybu textilie stačí dodat pouze první dvě hodnoty. 

 

 
Obrázek 8 - Kalkulátor ohybu 

 

Textilní vzorek obdelníkového formátu o rozměru 10 x 22 cm se položil 

na vyvýšenou desku (v případě experimentu výška 20 mm). Většina materiálu leží 

na spodní desce. Pomalým tahem je tkanina na vyvýšené desce posouvána až do doby, 

kdy se okraj tkaniny začne oddělovat od povrchu spodní desky. Okraj textilie se musí 

dotýkat spodní desky, nikdy nesmí viset. 
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Měření se provedlo desetkrát ve směru osnovy i útku na všech třech vzorcích 

tkanin. Vysledky měření jsou uvedeny v příloze B.  

 

 
Obrázek 9 – Měření ohybové tuhosti 

 

5.5 Výsledky měření KES – FB 

Přístroje Kawabata umožňují měřit některé mechanické vlastnoti plošných 

textilií.Byla naměřena tažnost, smykové charakteristiky a tuhost v ohybu. Z důvodu 

nekompatibility jednotek a jiných podmínek při měření nebyla naměřená data 

pro vizualizaci oděvuv práci použita.  

Zjištěná data jsou k nalezení v příloze B. 

  



25 
 

6 Charakteristika vybraného oděvu 

Pro virtuální zobrazení oděvu byly vybrány dámské šaty (viz Obrázek 10) 

s princesovým členěním, délkou ke kolenům a bez ramínek. Tento typ oděvu se zdál být 

nejvíce vhodný pro sledování padnutí oděvu na třech typech dámských postav, kterými 

jsou:  

• typ postavy s úzkými boky (velikost 038), 

• typ postavy s normálními boky (velikost 38), 

• typ postavy se širokými boky (velikost 538). 

 

 
     Obrázek 10 – Dámské šaty 

 

Základní konstrukce dámských šatů vychází z konstrukční metodiky NVS 

(viz příloha C) a z německého velikostního sortimentu DOB velikosti 38. Tělesné 

rozměry velikostí 38, 038 a 538 jsou uvedeny v tabulce 7. 
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Tabulka 7 Tělesné rozměry velikostního sortimentu DOB 

Číslo velikosti 038 38 538 
vp 168 168 168 
oh 88 88 88 
op 69 72 75 
os 91 97 103 
ok 36 36 36 
dz 41,6 41,6 41,6 
šz 16,5 16,5 16,5 
šr 12,2 12,2 12,2 

 

Základní střih byl ručně narýsován v měřítku 1:1 a následně mírně upraven. 

Úprava proběhla v umístění členění. Upravený střih se nadigitalizoval digitizérem a díly 

byly transformovány do elektronické podoby v softwaru Invesmark Futura 

a exportovány do vektorového formátu DXF. V příloze C jsou uvedeny pomocné 

výpočty pro tvorbu konstrukční sítě a úpravy vytvořené na základním střihu. 

6.1 Modelace šatů v AccuMarku 

Před provedením simulace v programu V-Stitcher je důležité transformovat 

střihovédíly do počítače a upravit je v AccuMarku. Umožňuje spravovat celé modely, 

stupňovat střihové modelace a upravovat díly. 

Jestli byla digitalizace provedena přesně nebo alespoň v intervalu s přesností 

± 5mm (toleruje 3D vizualizace v programu V-Stitcher), se zjistí na hlavní liště 

v záložce Měření. Měřit lze délku linie, vzdálenost linií, vzdáleností bodů apod.  

K vypracování bakalářské práce bylo potřeba díly zmenšit v oblasti horní 

poloviny těla (viz Obrázek 11). Konstrukce vytvořená podle metodiky NVS 

neodpovídala virtuální postavě vytvořené na tělesné rozměry o velikosti 38 velikostního 

sortimentu DOB. 
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     Obrázek 11 – Úprava střihových dílů  

 

Pro posun bodů slouží záložka v menu na horní liště Bod → Změny bodu 

→ označit posouvaný bod → potvrdit OK → Kurzor → zadat hodnoty posouvaného 

bodu v horizontálním a vertikálním směru. Nebo posunout celou linii Linie → Změnit 

linie → Modifikovat nebo Změnit délku → označit linii a zadat hodnoty. 

U dílů, které jsou symetrické a mají například přehyb, se nastaví symetrie 

v menu na horní liště Díl → Zrcadlový díl → kliknout na zrcadlovou linii a vytvoří 

se symetrie (plná čára se změní na čárkovanou). Symetrii lze zkontrolovat 

ve vlastnostech dílu nebo na horní liště Díl → Sklopit nebo Rozložit zrcadlový díl. 

Tvorba nového modelu a přidání dílů do modelu se provádí v dialogovém okně 

Gerber Launch Pad v AccuMark Explorer. Nový model se vytvoří na hlavním panelu 

nástrojů Soubor → Nový → Model, zadat název modelu a v dialogovém okně vyhledat 

díly patřící do vytvořeného modelu. 
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7 Program V-Stitcher 

7.1 Pracovní prostředí 

Pracovní plochaV-Stitcheru je rozdělena do tří hlavních částí: 

• 2D pracovní plocha pro práci se střihovými díly, šitím a aplikováním 

textur, 

• panely příkazů – menu na horní liště (viz Obrázek 12) a ikonické menu 

(viz Obrázek 13 ) a hlavní menu (viz Obrázek 14), 

• 3D okno pro vizualizaci výrobků na 3D virtuálních tělech (avatarech). 

 

 
                             Obrázek 12– Menu na horní liště 

 
Obrázek 13 - Ikonické menu 

 
Obrázek 14– Hlavní menu 

7.2 Vytvoření oděvní tabulky a databáze zdroje oděvu 

Po načtení střihových dílů z adresáře (Menu na horní liště → Plugin → Import 

AccuMark) je důležité zkontrolovat a upravit oděvní kartu Garment Map(viz Obrázek 

14). Ta se otevře po kliknutí na ikonu s názvem G Map v ikonickém menu. Poskytuje 

informace o typu a vrstvě oděvu, použitém velikostním sortimentu, identifikačním čísle 

oděvu, pohlaví, věkové skupině, sezóně ročního období a styluvýrobku. Garment Map 

pevně souvisí s Reference Management, většinu informací odvozuje z jeho nastavení. 

 



29 
 

 
Obrázek 14 – Garment Map 

 

V záložceReference Management (Menu na horní liště → Tools → Reference 

Management) se přepne na záložku Store Size → Female, kde se vytvoří velikostní 

sortiment v odkazu s názvem Size Chart. Kliknutím se přejde do tabulky pro vkládání 

čísla velikostí a tělesných rozměrů. K vyplnění se použije Add a pro uložení Update. 

Pro práci byl použit velikostní sortiment (Store Size Type) předem 

nadefinovaný, shodný s německým sotimentem DOB. K základním rozměřům 

zadávaným do tabulky patří obvod hrudníku (Bust), obvod pasu (Waist) a obvod sedu 

(Hip). 

7.3 Uspořádání střihových dílů na pracovní ploše 

Pro pokračování v simulaci je třeba díly uspořádat a srovnat tak, aby byl systém 

schopen je na virtuální postavu následně obléci. U oděvních dílů oblékající virtuální 

postavu musí být díly srovnány tak, že referenční linie je vertikálně. U dílů rukávu leží 

díly horizontálně. Díly se rotují přes hlavní menu Fitting → Shapes → Rotate. 

Nejdříve se kliknutím myši označí díl, který má být rotován, a do tabulky se zadá úhel 

rotace. Posun dílů po pracovní ploše se provádí pomocí tlačítka Move v ikonickém 

menu.  

Někdy je nutné díly překlopit ve svislé nebo vodorovné poloze, k tomu slouží 

postup Shape → Flip X nebo Flip Y → kliknout na díl, který se má otočit.  
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V hlavním menu Fitting → Shape → Symmetry můžeme dodělat nebo upravit 

definování symetrie dílů, pokud tak nebylo učiněno v AccuMarku. 

7.4 Seskupení střihových dílů 

Vytvořením jednotlivých clusterů (viz Obrázek 15) se dosáhne správnosti 

zobrazení střihových dílů v 3D simulaci postavy. Jelikož program začíná simulaci 

postavy od předního dílu, je nezbytné definovat u clusteru umístění a typ ovinutí.  

Nový cluster se vytvoří pomocí Fitting → Clusters → New → kliknout 

a táhnout oknem výběru okolo všech dílů. Po vytvoření se clustery definují pro každý 

díl zvlášť. Postup při přiřazení informace o clusteru Clusters → Edit→ vybrat díl. 

 

 
Obrázek 15 –Skupiny dílů 

 

Podle druhu oděvu zadaném v oděvní kartě Garment Map nabídne nabídka 

clusteru (viz Obrázek 16 a Obrázek 17) typ umístění (Location) a typ ovinutí (Wrap 

type): 

• umístění:  Front (přední díl), 

Back (zadní díl), 
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Left (díly umístěné na virtuální postavě na levém boku), 

Right (díly umístěné na virtuální postavě na pravém boku), 

Straps (ramínka), 

Collar (límec), 

Belt (opasek), 

Hood (kapuce), 

 

• typ ovinutí: None (žádný), 

Rounded (ovinutí kolem těla), 

Left (vlevo), 

Right (vpravo), 

Sleeve (rukáv), 

Cuff (manžeta). 

 

 
Obrázek 16 – Definování clusteru 2 

 
Obrázek 17 – Definování clusteru 5 

 

Vytvořené clustery střihových dílů šatů jsou uvedeny níže v tabulce 8. 

 

Tabulka 8: Definované skupiny střihových dílů šatů 

Cluster Oděvní díl Umístění 
(Location) 

Typ ovinutí 
(Wrap type) 

Cluster 2 Přední středový díl Front None 
Cluster 3 Pravý přední díl Front Right 
Cluster 4 Levý přední díl Front Left 
Cluster 5 Zadní středový – levý díl Back Left 
Cluster 6 Zadní středový – pravý díl Back Right 
Cluster 7 Levý zadní díl None Left 
Cluster 8 Pravý zadní díl None Right 
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7.5 Úprava dílů před sešitím 

Před sešitím dílů je nutné díly zkontrolovat a popřípadě upravit tak, aby byla 

zajištěna správná simulace. Pro práci se střihovými díly slouží záložka v hlavním menu 

Fitting → Shapes. Zde se dají jednotlivé díly vytvořit, kopírovat, otáčet rotovat, mazat 

apod. 

Pro umístění ramínek, rukávu nebo určení například vrcholu záševku je potřeba 

do dílu přidat body, k tomu slouží záložka v menu Fitting → CAD Plugin(viz Obrázek 

18)→ Create Curve Point nebo Create Straight Point → kliknout pro umístění bodu. 

Curve Point se použije na obrys dílu a křivce, Straight Point pouze na přímku.V práci 

byly body přidány do pasové linie pro správné sešití dílů. 

Pokud je potřeba bod umístit nebo přesunout s přesnou vzdáleností, použije 

se funkce dynamického měřítka v hlavním menu Fitting → CAD Plugin → Dynamic 

Ruler. 

 

 
                       Obrázek 18 – Nabídka CAD Plugin 

 

V záložce CAD Plugin → Point’s Attribute → otevře se dialogové okno 

s atributy bodu. U bodu lze měnit druh na rovný (Straight), zaoblený (Curve), vrt 

(Drill), pozice značky (Position Mark) a nebo typ bodu na pevný bod (Corner), zářez 

(Notch) a průběžný bod (Pin Point).  
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7.6 Sešití střihových dílů šatů 

Program umožňuje sešití linií šatů interaktivně tak, jak technologicky náleží. 

V hlavním menu Seam → Stitch→ Regularse otevře dialogové okno a kurzor myši 

se změní na jehlu. Prvním kliknutím se označí sešívaný okraj a druhým okraj, se kterým 

se má sešít. Žluté čáry naznačují sešití okrajových bodů a dílů. Okrajové linie jsou 

označeny modrou barvou přecházející do bílé, vyznačují tak začátek a konec šití 

(viz Obrázek19). Podle barevného přechodu a žlutých čar lze zjistit, zda-li nejsou díly 

sešívány překříženě. V takovém případě je nutné začátek a konec šití změnit Seam 

→ Stitch → Flip. 

 

 
Obrázek 19– Sešití střihových dílů 

 

Pro viditelné znázornění sešívaných okrajů je dobré mít aktivovamou funkci 

zobrazení šití. Aktivuje se z menu na horní liště View → Show → Stitches. 

U složitejších a členitých druhů oděvů může dojít při interaktivním sešívání 

k chybě, proto lze jednotlivé šicí linie mazat v menu Seam → Stitch → Verify list 

(Obrázek20). Funkce slouží k zobrazení seznamu všech šitých hran, včetně jejich délek. 

Pokud mají linie stejnou délku, šití je Delta 0. Program připouští toleranci ± 0,5 cm. 

Pokud je šev v dialogovém okně označen, zvýrazní se i na pracovní ploše.  
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Obrázek 20 – Tabulka délek dílů 

 

7.7 Definování materiálu 

Definování materiálu je dalším důležitým krokem pro vytvoření oděvu. Definuje 

se nejenom design oděvního materiálu, ale i materiálové složení, struktura materiálu 

a mechanické vlastnosti. 

Pro použití vlastního designu materiálu se musí obrázek materiálu importovat 

do prostředí V-Stitcher. Materiál lze oskenovat nebo vyfotit, popř. ještě upravit, vyvážit 

barvy v nějakém grafickém programu.  

7.7.1 Vložení nového materiálu 

Pro vytvoření nového materiálu se používá funkce z hlavního menu Fabrics 

→ New. Objeví se dialogové okno, do kterého se v prvním kroku zadají informace 

týkající se struktury materiálu a materiálového složení. Druhým krokem se nahraje 

obrázek definovaného materiálu z knihovny. 

V rámci experimentu bylo potřeba změnit některé předem definované 

mechanické vlastnosti materiálů, ty lze změnit v záložce Fabrics → Properties.  

Tabulka Fabric Properties zobrazuje hodnoty mechanických vlastností všech tří 

materiálů zadaných do dialogového okna (viz Obrázek 21, 22 a 23). 
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Do tabulky byly vloženy vlastní hodnoty plošné měrné hmotnosti (Mass), 

tloušťky (Thickness) a ohybu (Bend) (viz tabulka 9). Ohyb materiálu byl měřen pomocí 

praktické metody, která vychází z manuálu programu. Jeho hodnoty jsou uvedeny 

v příloze B a zadávají se do kalkulátoru ohybu (viz Obrázek 8). Ostatní hodnoty 

vycházejí ze softwaru V-Stitcher, protože data z měření realizovaného pomocí 

Kawabata systému nemohou být použita. Důvodem je použití jiných jednotek a jiných 

podmínek měření, které nelze převést. Zjištěná data měření jsou k nalezení v příloze B. 

 

Tabulka 9: Hodnoty mechanických vlastností zadaných do vlastností materiálu 
Materiál č.  1 2 3 

Hmotnost (Mass) [g.m-2] 150,6 83,4 262,6 

Tloušťka(Thickness)[mm] 0,35 0,20 0,57 

Ohyb (Bend) 
[dyn*cm] 

Osnova 
(Length) 

Délka (Length)  
[cm] 

2,97 3,77 6,31 

Vzdálenost (Distance) 
[cm] 

2,02 2,89 6,74 

Výška (Height) 
[cm] 

2 2 2 

Útek 
(Width) 

Délka (Length)  
[cm] 

2,97 3,14 4,51 

Vzdálenost (Distance) 
[cm] 

1,79 2,13 5,14 

Výška (Height) 
[cm] 

2 2 2 
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Obrázek 21 – Mechanické vlastnosti  

materiálu č. 1 

 
Obrázek 22 – Mechanické vlastnosti  

materiálu č. 2 



37 
 

 
                       Obrázek 23 – Mechanické vlastnosti materiálu č. 3 

 

V softwaru lze textilii simulovat na všech dílech najednou, popř. na vybrané díly 

(Fabrics → Assign to All).  

7.8 Zobrazení oděvu na virtuální postavě 

Po nadefinování všech informací v 2D pracovním okně je možné provést 3D 

vizualizaci oděvního výrobku pomocí ikonického tlačítka 3D. 

Nejprve se musí vybrat typ avatara, na kterém bude simulace provedena, 

a nastavit jeho tělesné rozměry do tabulky definující postavu (viz Obrázek 24 ). 

• Výběr typu avatara – Avatar → New (virtuální postava muže, ženy 

a dětí v různém věku), 

• výběr pózy – Avatar → Poses, 

• definování postavy – Avatar → Modify. 
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                          Obrázek 24 - Definování tělesných rozměrů avatara 

 

Nejvíce ovlivňujícím aspektem při definovaní tělesných rozměrů v tabulce je 

věk a výška avatara. Při zadávání rozměrů zastoupeného malým počtem populace, 

např. s neobvyklým obvodem sedu, velkým obvodem hrudníku, se musí pozměnit věk 

(Age) a velikost (Body Size), aby zadané hodnoty odpovídaly potřebným rozměrům. 

Tyto rozměry musí souhlasit i s tělesnými rozměry uvedenými v Garment Map 

nebo Reference Management, jinak nemůže být simulace provedena. 

Začátek simulace oděvu (viz Obrázek25) se zajistí spuštěním 3D pracovního 

okna a funkcí v ikonickém menu Dress. Zapnutí funkce pro zobrazení mřížky 

v simulaci se zkontroluje záložka Tools → Settings → záložka 3D, zaškrtnout funkce 

s názvem Show grid in simulation. 

 



39 
 

 
Obrázek 25 – Kontrola padnutí oděvů pomocí mřížky 

 

Po zobrazení mřížky je možné s jednotlivými díly (Shapes) pomocí klávesy Ctrl 

hýbat (Move) a rotovat (Rotate). Přesné padnutí oděvu i umístění dílů na virtuální 

postavě lze upravit pomocí clusterů, aby díly v některých místech neprotínaly postavu, 

nebo se nekřížily. 

Pomocí ikonického menu (Obrázek 26) se může virtuální postava přibližovat, 

oddalovat a měnit úhel pohledu, což vede k lepším možnostem pozorování padnutí 

simulovaného oděvu a náhledu vzniklých detailů. 

 

 
                      Obrázek 26 – Ikonické menu pro pohybování avatara 

 

Po kontrole správného padnutí oděvu mřížkou se může oděv na virtuální postavu 

obléknout i se zobrazením nadefinovaného materiálu. Výsledné zobrazení by mělo 

odpovídat realistickému vzhledu, který byl vstupním parametrem mechanických 

vlastností textilních materiálů. 
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7.8.1 Hodnocení 3D vizualizací oděvu 

Za účelem sledování padnutí oděvu byly vybrány dámské šaty simulované 

na typu postavy s normálními, úzkými a širokými boky na všech třech oděvních 

materiálech (viz Tabulka 10, 11 a 12) s rozdílným materiálovým složením, vazbou, 

plošnou měrnou hmotností apod. 

V tabulkách 13, 14 a 15 je zobrazena mřížka s ukázkou pnutí (napětí) materiálu. 

Zobrazení slouží pro kontrolu padnutí oděvu na postavě. Barevnost mřížky přechází 

od bílé barvy přes světle modrou, zelenou, žlutou, oranžovou až červenou. Červená 

barva znamená, že oděv je postavě malý a střihové díly se musí zvětšit.  

Hodnocení padnutí oděvu na virtuálním avatarovi je vytvořeno na základě 

pozorování z různých úhlů pohledů. 
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Tabulka 10: Simulace materiálu č. 1 ve velikosti 038, 38, 538  
Velikost 038 Velikost 38 Velikost 538 
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Tabulka 11: Simulace materiálu č. 2 ve velikosti 038, 38, 538 
Velikost 038 Velikost 38 Velikost 538 
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Tabulka 12: Simulace materiálu č. 3 ve velikosti 038, 38, 538 
Velikost 038 Velikost 38 Velikost 538 
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Tabulka 13: Zobrazení napětí textilie u materiálu č. 1 
Velikost 038 Velikost 38 Velikost 538 
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Tabulka 14: Zobrazení napětí textilie u materiálu č. 2 
Velikost 038 Velikost 38 Velikost 538 
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Tabulka 15: Zobrazení napětí textilie u materiálu č. 3 
Velikost 038 Velikost 38 Velikost 538 

 

 

 

 

 

 
 

Hodnocení oděvu velikosti 038 – úzké boky 

Proužkovaný hnědo-pískový materiál (materiál č. 1) padne postavě nejlépe, nijak 

nezdůrazňuje úzké boky. Z bočního pohledu je vidět, že zadní díl šatů je delší, dolní 

okraj netvoří s rovinou země rovnoběžnou linii. 

Na všechny simulované šaty byly díly umístěny naprosto stejně, ale u velikosti 

038 s puntíkatým materiálem (materiál č. 2) jsou níže posazeny v předním díle než 

u všech ostatních. Níže posazený přední díl způsobil, že zadní díl působí kratší. I když 

má materiál č. 2 větší ohybovou tuhost než materiál č.1, vytváří více záhybových ploch, 

což by mělo být naopak. Jev může být způsoben ostatními mechanickými vlastnostmi. 
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Žlutý materiál (mechanické vlastnosti odpovídají materiálu č. 3, pouze byl 

změnen dezén tkaniny pro lepší vizualizaci) má nejvyšší hodnotu ohybové tuhosti. Šaty 

z čelního pohledu odstávají a trčí, mírně zvlněné záhyby způsobila ohybová tuhost  

 

Hodnocení oděvu velikosti 38 – normální boky 

Střih šatů byl zhotoven a upraven na tělesné rozměry velikosti 38, proto 

vytvořený střih postavě nejvíce padne. 

U materiálu č. 1 se šaty v zadním díle v oblasti pasu horizontálně vrásní díky 

malé ohybové tuhosti. 

 

Hodnocení oděvu velikosti 538 – široké boky 

S rozšiřujícími boky se šaty u všech materiálů zkracují (při namáhání v útku 

se zkracují osnovní nitě).  

U materiálu č. 3 by měl být střih v sukňové části rozšířen v oblasti sedu, protože 

v zadním i předním díle dochází  k velkému pnutí (napětí) textilního materiálu. 

7.8.2 Vyhodnocení experimentu 

Pro lepší názornost vyhodnocení padnutí oděvu je níže uvedena srovnávací 

tabulka 16. Tabulka srovnává vytvořené simulace podle počtu a hloubky záhybů, pnutí 

materiálu, vrásnění dílů, rovnoběžné linie dolního kraje oděvu se zemí. 

Výsledné padnutí je hodnoceno podle škály od jedné do pěti. Číslo jedna 

znamená nejméně a číslo pět nejvíce. Podle pětimístné škály byla hodnocena: 

• hloubka vytvořených záhybů na zadním díle, 

• pnutí materiálu (č. 1 – bílá mřížka, č. 2 – modrá, č. 3 – modrá, zelená 

a žlutá, č. 4 – převaha žluté nebo až oranžové, č. 5 – červená), 

• nevyhovující vrásnění.  

Množství záhybů je vyjádřeno počtem vytvořených záhybů. Rovnoběžnost 

dolního okraje oděvu s povrchem země je hodnocena slovně – kratší, delší 

a rovnoběžný, kolonka v tabulce „Jiné jevy“ hodnotí ojedinělé jevy simulace. 
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Tabulka 16: Vyhodnocení padnutí oděvu 

Materiál 
Počet 

záhybů 
na ZD 

Hloubka 
záhybů 

Pnutí 
materiálu 

Nevyhovující 
vrásnění 

Rovnoběžná 
linie ZD 

Jiné jevy 

Velikost 038 
1 2 2 3 2 delší  

2 4 5 2 1 kratší 
nízko 
posazený 
PD 

3 2 1 3 3 rovnoběžný  
Velikost 38 

1 2 3 3 4 rovnoběžný  
2 3 4 2 1 kratší  
3 2 3 3 3 kratší  

Velikost 538 
1 2 4 4 5 kratší  
2 5 3 2 1 kratší  
3 2 2 4 2 kratší  
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Závěr 

Cílem bakalářské práce bylo sledovat výsledky 3D simulace na virtuální postavě 

v programu V-Stitcher z pohledu typu postavy a druhu materiálu.  

V teoretické části jsou popsány mechanické vlastnosti plošných textilií 

ovlivňující padnutí oděvu na postavě a studie zabývající se typovou charakteristikou 

ženských postav.  

Jako simulovaný oděv pro vyhodnocení experimentu byly vybrány dámské 

přiléhavé šaty bez ramínek s princesovým členěním. Na sukňové části šatů se nejlépe 

projeví vlastnosti oděvních materiálů, které mají být hodnoceny a porovnávány. 

Po digitalizaci střihové konstrukcedo elektronické podoby byly díly v programu 

AccuMark postupně upraveny tak, aby mohlo dojít k následnému zobrazení dámských 

šatů na 3D virtuální postavě.  

Před výběrem materiálů pro 3D simulaci bylo provedeno na deseti vzorcích 

měření splývavosti metodou obrazové analýzy se softwarem Lucia. Na základě 

výsledků měření se vybraly tři materiály s rozdílným materiálovým složením, vazbou, 

plošnou měrnou hmotností a koeficientem splývavosti. Jedním z cílů této bakalářské 

práce bylo provést laboratorní metodou měření vybraných mechanických vlastností 

plošných textilií. Jak uvádí helpy a manuál softwaru V-Stitcher, lze některé mechanické 

vlastnosti hodnotit pomocí měřících přístrojů – FAST (Fabric Assurance by Simple 

Testing) a FTK (Fabric Testing Kit), který je vyroben výrobcem Browzwear. Některá 

světová literatura uvádí i možnost použití dat ze systému přístrojů KES 

(NguyenThiThuy Ngoc, Hoang Ngoc Anh, Investigating on fabric and skirt drape 

in clothingconstruction, 2010). Naměřená data je možné importovat a použít pro 3D 

vizualizaci oděvu na avatarovi. Po vyhodnocení dat naměřených přístroji KES (tažnost, 

smykové charakteristiky a tuhost v ohybu) bylo zjištěno, že data nemohou být použita. 

Software je nekompatibilní, pracuje s jinými jednotkami a jinými podmínkami 

při měření, které nelze nijak převést. Proto se při definování materiálu zadávaly hodnoty 

tloušťky, plošné měrné hmotnosti a tuhosti v ohybu, která se změřila podle návodu 

manuálu V-Stitcher. Do softwaru se nezadávaly hodnoty splývavosti, ty byly použity 

pouze pro výběr materiálu. Ostatní potřebné údaje zůstaly podle předem nadefinovných 

hodnot, což mohlo velmi ovlivnit výslednou simulaci. Řešením by mohlo být změření 

mechanických vlastností pomocí FASTu, na který existuje pro software V-Stitcher 



50 
 

konvertor. Bohužel se v České republice žádný přístroj FAST nenachází, tudíž nelze 

zjistit výsledné objektivní výsledky. 

V programu V-Stitcher byly díly postupně upraveny, aby mohlo dojít k jejich 

zobrazení na virtuální postavě. Virtuálnímu zobrazení předchází přesné zadání 

informací o oděvním výrobku, tělesných rozměrech avatara a v neposlední řadě také 

přesné definování materiálu, z něhož bude výrobek vyhotoven. Při definování tělesných 

rozměrů virtuální postavy avatara jsem se setkala s problémem nadefinovat přesné 

hodnoty podle velikostního sortimentu DOB. Hodnoty nejvíce ovlivňuje výška avatara 

a věk, u jiných avatarů to je i např. obvod hrudníku, pasu, sedu a obdvod krku. Každý 

avatar má jinou morfologickou stavbu těla a to ovlivňuje zadávání hodnot. Problém 

nastane při definování obvodu hrudníku a obvodu pod prsy. Program neumožňuje 

nastavit velký rozdíl mezi těmito hodnotami. Obvod sedu ovlivňuje vystouplost břicha, 

obvod boků, stehen, kolen, lýtek a kotníků. U některých typů avatarů nelze při výšce 

168cm ve věku 20 let nastavit větší obvod sedu než 101cm, při zvýšení věku na 30 let 

se hodnota změní na 105cm. Při zadávání obvodu pasu se mění obvod krku, 

pro docílení požadované hodnoty obvodu krku se musí změnit obvod pasu nebo výška 

a věk avatara.Toto je pouze malá část problémů, na které jsem během práce v programu 

přišla. Troufám si ale tvrdit, že program je velmi omezen možnostmi zadávání tělesných 

rozměrů, verze programu může být zastaralá. 

Pomocí srovnávácí tabulky, která sloužila pro názornější vyhodnocení simulací 

provedených na třech typech ženských postav se všemi třemi rozdílnými materiály, byl 

vyhodnocen experimet. Dle zvoleného typu šatů a materiálu se jevila nejlépe velikost 38 

s použítým materiálem č. 2. Materiál č. 2 dosahoval nejnižších hodnot v pnutí materiálu, 

nejméně se vrásnil a měl nejvyšší počet záhybů na zadním díle. U velikosti 038 jsou 

přední díly nízko posazeny a způsobují, že zadní díl je kratší. Materiál č. 1 vytváří 

nejvíce nevyhovující vrásnění v pasové linii. Materiál č. 3 je na daný oděv příliš tuhý 

(vysoká ohybová tuhost). U materiálu č. 2 a č. 3 je délka šatů závislá na obvodových 

rozměrech sedu. S roustoucími rozměry se šaty zkracují. 

Výstupem celé práce je metodický postup pro 3D vizualizaci oděvního výrobku 

v softwaru V-Stitcher na zvolený materiál a ověření střihu na danou velikost v systému 

AccuMark.  

Závěrem lze říci, že virtuální zobrazení jsou pro dnešní dobu velmi aktuální. 

Mohou být užitečné ve vývoji oděvních výrobků, v prezentacích virtuálních přehlídek 

a při sdílení kolekcí s odběrateli a dodavateli v předvýrobním, výrobními prodejním 
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procesu. Zákazník si tak může v softwaru nasimulovat střih vhodný pro jeho typ 

postavy, dezén, materiál a zobrazit oděv na virtuální postavě před vyhotovením. Dle 

mého názoru ale zatím nejsou tyto programy schopny pracovat plně vědecky 

s objektivně měřícími přístroji. 
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Příloha A 
  



 
 

Rovnice pro výpočet a analýzu somatotypu  

Endomorfie = - 0,7182 + 0,1451 (Y) – 0,00068 (Y2) + 0,0000014 (Y3) 

Mezomorfie = (0,858 HB + 0,601 FB + 0,188 CAG + 0,161 CCG) – (0,131 H) + 4,5 

Ektomorfie: 

Pokud HWR ≥ 40,75, pak Ektomorfie = 0,732 HWR – 28,58 

Pokud HWR < 40,75 a > 38,25, paEktomorfie = 0,463 HWR – 17,63 

Pokud HWR ≤ 38,25, pak Ektomorfie = 0,1 

 

 Y (součet tricepsové, podlopatkové a nadpáteřní kožní řasy) * 

(170,18 / výška postavy v cm), 

 HB šířka pažní kosti, 

 FB šířka stehenní kosti, 

 CAG korigovaný obvod paže = obvo ohnuté paže – pažní kožní řasa / 10, 

 CCG korygovaný obvod lýtka = maximální obvod lýtka – lýtková kožní 

řasa / 10, 

 H výška postavy, 

 HWR výška postavy / třetí odmocnina tělsné hmotnosti 

  



 
 

 
 
 
 

Příloha B 
  



 
 

Výsledky měření mechanických vlastností materiálů    – aritmetický průměr: 

  ̅ =    ∑          s2 – rozptyl: s =      ∑ ( x      – x )   

s – směrodatná odchylka:  =  √    

v = variační koeficient:   =    ̅ . 10   [%]        

 
Tabulka 1: Naměřené hodnoty  a stanovení koeficientu splývavosti X 
Materiál Plocha průmětu Sp [mm2] x [mm2] s [mm2] v [%] X [%] 

1 34050,45 35340,23 35546,65 35721,88 35164,8 657,5 1,87 78,53 
2 50081,66 49719,78 49120,50 48829,08 49437,76 491,3 0,1 46,98 
3 61787,16 62850,63 63093,49 63091,99 62705,82 539,5 0,86 17,65 
4 33616,75 32593,15 33428,05 31929,65 32891,9 676 2,05 83,55 
5 35970,97 36204,52 36996,72 36606,38 36444,65 391,5 1,07 75,7 
6 32880,95 33238,92 33853,82 33837,17 33452,72 412,7 1,23 82,31 
7 36295,55 35658,13 35573,95 34984,05 35627,97 464,8 1,3 77,5 
8 34058,09 35551,92 34526,18 35030,61 34791,7 557,6 1,6 79,35 
9 37120,46 37061,46 37280,32 35642,11 36776,09 659,6 1,79 74,96 

10 38653,2 38497,75 37377,08 36816,75 37836,2 767,3 2,02 72,58 
 

Tabulka 2: Naměřené hodnoty tloušťky materiálů 
Mater. 

č. 
Tloušťka materiálů  [mm] x [mm] 

s 
[mm] 

v 
[%] 

1 0,34 0,34 0,35 0,34 0,35 0,35 0,35 0,35 0,34 0,35 0,35 0 1,42 
2 0,20 0,20 0,20 0,20 0,20 0,21 0,19 0,20 0,21 0,19 0,20 0,01 3,16 
3 0,58 0,58 0,58 0,54 0,58 0,58 0,58 0,58 0,58 0,57 0,57 0,01 2,09 

 
 
 
 
 



 
 

Tabulka 3: Hodnoty naměřené plošné měrné hmotnosti 
Materiál č. 1 2 3 

Hmotnost vzorku[g] 

1,502 0,833 2,625 
1,505 0,834 2,625 
1,507 0,834 2,626 
1,506 0,833 2,626 
1,509 0,833 2,626 
1,509 0,835 2,627 
1,506 0,833 2,627 
1,503 0,834 2,625 
1,506 0,833 2,626 
1,505 0,833 2,626 x [g] 1,506 0,834 2,626 

s [g] 0,002 0 0 
v [%] 1,33 0,08 0,03 

Plošná měrná hmotnost [g.m-2] 150,6 83,4 262,6 
 

Tabulka 4: Naměřené hodnoty ohybu materiálu č. 1 

Měření 
Osnova Útek 

Vzdálenost [cm] Délka převisu [cm] Vzdálenost [cm] Délka převisu [cm] 
1 1,9 3,1 1,7 2,8 
2 2,5 3,2 1,8 2,7 
3 2,2 2,9 1,8 3 
4 1,9 2,9 1,9 3,1 
5 2,5 3 1,8 3 
6 1,85 2,9 1,8 3,1 
7 2 3,2 1,7 3 
8 1,85 2,9 1,8 3 
9 2 2,8 1,8 3,1 
10 1,9 2,7 1,8 2,8 x [mm] 2,02 2,97 1,79 2,97 
s [mm] 0,24 0,16 0,05 0,14 
v [%] 11,88 5,38 2,79 4,71 

 
  



 
 

Tabulka 5: Naměřené hodnoty ohybu materiálu č. 2 

Měření 
Osnova Útek 

Vzdálenost [cm] Délka převisu [cm] Vzdálenost [cm] Délka převisu [cm] 
1 2,95 3,9 2,15 3,1 
2 2,85 3,9 2,1 3,2 
3 3 3,9 2,15 3,1 
4 2,95 3,6 2,15 3,2 
5 2,8 3,65 2,1 3,3 
6 2,9 3,6 2,2 3,1 
7 2,9 3,8 2,1 3 
8 2,85 3,8 2,1 3,1 
9 2,9 3,7 2,15 3,1 
10 2,8 3,8 2,1 3,15 x [mm] 2,89 3,77 2,13 3,14 
s [mm] 0,06 0,11 0,03 0,07 
v [%] 2,07 2,91 1,4 2,22 

 
Tabulka 6:Naměřené hodnoty ohybu materiálu č. 3 

Měřění 
Osnova Útek 

Vzdálenost [cm] Délka převisu [cm] Vzdálenost [cm] Délka převisu [cm] 
1 6,1 6,7 4,4 5,2 
2 6,6 6,5 4,5 5,3 
3 6,1 6,7 4,4 5 
4 6,2 6,6 4,7 5 
5 6,4 6,9 4,55 5,2 
6 6,2 6,7 4,7 5,3 
7 6,6 6,9 4,4 5 
8 6,4 6,9 4,3 5 
9 6,2 6,8 4,6 5,2 
10 6,25 6,7 4,5 5,2 x  [mm] 6,31 6,74 4,51 5,14 
s [mm] 0,18 0,13 0,13 0,12 
v [%] 2,85 1,93 2,88 2,33 

 



 
 

 
Obrázek 1 – Výstup materiálu č. 1 z KES sytému 

 

 
Obrázek 2 – Výstup materiálu č. 2 z KES sytému 

 



 
 

 
Obrázek 3 – Výstup materiálu č. 3 z KES sytému 

 

  



 
 

 
 
 
 

Příloha C 
  



 
 

Tabulka 7: Pomocné výpočty pro konstrukční síť zadního dílu 
P.č. Rozměr Vzorec Výpočet 
1. zadní středová přímka   
2. krční  přímka   
3. zadní hloubka podpaží 0,1vp + 0,05oh + P (0,5) 21,7 cm 
4. délka zad dz 41,6 cm 
5. sedová přímka 0,1vp + 3 19,8 cm 
6. přímka délky oděvu do 98cm 
7. tvarování ZD k = 1,5  
8. odklon zadní střed. př.   
9. šířka zad 0,5 šz + 0,5 + P (0) 17 cm 
10. zadní průramková př.   
11. šířka průramku 0,125oh + 0,5 + P (0) 11,5 cm 
12. přední průramková př.              
13. šířka přední 0,2oh + 1,5 + P (0) 19,1cm 
14. přední středová přímka             
15. boční hrudní bod 0,5 H3 H5 + 1 6,75 cm 
16. boční přímka   
17. prsní bod 0,1oh + 0,5 9,3 cm 
18. prsní přímka   
19. šířka průkrčníku z. d. 0,165ok + 0,75 6,69 cm 
20. boční krční přímka   
21. výška průkrčníku z. d. 0,05ok + 0,25 2,05 cm 
22. bod pro vykr. průkr. š. průkrčníku + 1,0 7,69 cm 
  š. průkrčníku + 1,0 7,69 cm 
23. vykreslení průkrčníku   
24. sklon náramenice 0,5 šz 16,5 cm 
  0,1 zhp - 0,75 1,42 cm 
25. šířka náramenice šr+Pv(0,5)+Pt(0,25)+1,75 14,7 cm 
26. umístění ramen. vybrání 0,05oh + 0,5 4,9 cm 
27. př. lopatková (vybrání) 0,5 H11 H3 + 1 9,5 cm 
28. šířka vybrání k = 1,75  
29. délka vybrání k = 8  
30. zvýšení ram. vybrání k = 0,3  
31. zvýšení pas. př. na ZD k = 0,5  
32. vrchol vybrání na ZD k = 16 ÷ 18 17 cm 
33. zvýšení pasové přímky k = 1  

 

 

 

 

 



 
 

Tabulka 8: Pomocné výpočty pro konstrukční síť předního dílu 
P.č Rozměr Vzorec Výpočet 
34. zvýšení krční př. PD 0,05oh 4,4 cm 
35. urč. rozevř. prs. vybrání 0,05oh + 0,5 4,9cm 
36. pomoc. přímka   
37. šířka průkrč. PD 0,165ok + 0,75 6,69 cm 
38. hloubka průkrč. PD 0,165ok + 2,5 8,44 cm 
39. bod 02  pro vykr. průkr.  7,44 cm 
   7,44 cm 
40. vykreslení průkrčníku   
41. sklon náramenice k = 1,5 ÷ 2,5 2 cm 
42. vrchol prsního vybrání k = 1 1 cm 
43. prsní vybrání   
44. tvorba náranenice na PD  12,7 cm 
45. šíře náramenice   
46. přední část náramenice   
47. strany vybrání   
48. přední část náramenice   
49. tvarování průramku ZD 0,5šz + 1,5 19,7 cm 
  k = 1 1 cm 
50. pomoc. body 0,5 N4´H51  
  k = 1 1 cm 
51. montážní bod 0,25 H3H5 + 0,25 3,4 cm 
52. tvarování  průramku ZD   
53. tvarování  průramku PD   
54. hodnota vybrání na PD 0,25op - 1 17 cm 
55. přední pasové vybrání   
56. kontrolní rozměr 0,5op + 4 (3 ÷ 5) 39 cm 
57. boční pasové vybrání   
58. zadní pasové vybrání P11 P12 – P42 P42′  
59. rozdíl mezi os a oh P7P0 - 2  
  0,5os +2 50,5cm 
60. hodnota vybr. na sed. př.   
61. vybrání na sedové př. 0,5 S11S12  
  0,5 S0 S7  
62. úprava na dolní př.   
63. zvýšení náramenice na ZD k =1-2  
64. snížení náramenice na PD k =1-2  

 



 
 

 
Obrázek 4  – Konstukční síť simulovaného oděvu 
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